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The Remote Printer Management Utility

The Remote Printer Management Utility (RPMU) is a software tool for network administrators that allows
the configuration and control of InfoPrint Solutions Company printers remotely connected to the Ethernet
LAN. The software can be downloaded from our website:

www.infoprint.com
With this tool the installed printers may be controlled, configured and organized easily.

The main features are:

Device Discovery Searches for the devices within a range of IP addresses.

Printer Organization The printers connected to the network can be organized into logical groups
in a hierarchically structured tree.

Printer Status Report Checks the printer's status and reports alarms.

Printer Configuration The remotely connected printers may be configured as needed from the
administrator's workstation.

Firmware Updating Provides a firmware downloading function to upgrade both the base and
the LAN card firmware.

Remote Operator Panel Management  Provides a virtual operator panel for the remotely connected printer at the
administrator's workstation that allows to perform all functions normally
achieved pressing the operator panel keys.

The RPMU also provides the basic status management for third-party printers compliant to the standard
MIB objects.

Operating System Compatibility

The RPMU is a Java based application and can be run on any platform supporting the Java Run Time
Environment version 1.5 or newer.

© Copyright InfoPrint Solutions Company 2007 1



Installing the RPMU in the Windows environment

1. Run the SETUP.exe file to install the java SDK and follow the instructions.
2. Run RPMU (executable Jar file) from the shortcut on desktop. The RPMU displays the Login window.

Login Remote Printer Management Ukility 5[

Remote Printer Management Utility

User: Password:

| | | | Enter |

Change User or Password

HCOPF091
Figure 1. The RPMU Login Window
3. The Default User is “admin”; the Default Password is “admin”; and after the login and password entry

the main window appears:

‘__4 RPMU - Remote Printer Management Utility ¥0.6.0
File Edit ©  Scan Help

EIEEE --:;_ ol [sn]Z]x == B B[R m[a] 5]

=10l x|

HCOPG092

Figure 2. The RPMU Main Window
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How to change your Password
To change your Password select “Change User or Password” in the Login Dialog.

Login Remote Printer Management Utility il

Remote Printer Management Utility

User: Password:

| Change User or Password

HCOPG093

Figure 3. The Login Dialog

Enter the new User or new Password and Old PWD in the appropriate text boxes. Select the Modify
button.

The RPMU Main Window

The RPMU Main Window, [Figure 4 on page 4} is divided into three main parts:

Menu Bar Contains the four menus (File, Edit, Status, Scan, Printer Operation and
Help) used to control the functions of the program.

Tool Bar Contains the icons of the shortcuts for the most commonly used menu
functions.
Printer Database Window Displays an organized list of printers, configuration files, and firmware

download files.

The Remote Printer Management Utility 3



£ RPMU - Remote Printer Management Utility ¥0.6.0 7 = | Dli]
Menu Bar File Edit Scan Help

Tool Bar — g |~ |m @ @ @)+ n|l|/|x< -~ B RE D& &3

Printer Database
Window

HCOPG094

Figure 4. RPMU Main Window

The Menu Bar

The RPMU menu bar is located at the top of the main window and provides the following items:
* File Menu

* Edit Menu

» Status Menu

* Scan Menu

* Printer Configuration Menu

* Help Menu

The File Menu

The File menu offers the main file management functions for the printer databases.
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g RPMU - Remote Printer Manag

File | Edit Status

Hew Database
Open Database
Save to File
Exit

Lprint Fageh:

HCOPG095

Figure 5. The File Menu

New Database

Open Database

Save To File

Exit

Creates a new database file.

Opens an existing database.
Note: Only one database can be opened at a time. If a database is already open, you are

asked to save changes to the open database before creating the new one.

Saves the current database file. The program prompts you to enter a name for the file.

Ends the RPMU program.

The Edit Menu

The Edit menu allows you to manage the printer database contents: folders, printer devices, configuration

files, or firmware download files.

HCOPG108

|

Can

mpuprint P
del = Comg

1D Addvmmm — A

Figure 6. The Edit Menu

Insert Add a folder, a printer device, configuration file, or firmware download file in a previously

selected folder. A corresponding icon is placed in the folder:

The Remote Printer Management Utility
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This example shows the database Network Scan & B network Scan
containing the folder “Scan Folder” with some printer GIRT= a1 Folie
1cons: @ "°F IBM 4247-V03
IF Address=10.0.200.40
Metmask=255.0.0.0
~ User|D=root
@ ““§1BM 2247-003
IF Address=10.0.200.11
Metmask = 255.255.0.0
~ User|D=root
@ "5 IBM 4247-003
IP Address=10.0.200.42
MNetmask=0000
User|D = root

HCOPGO057

The Insert item offers these selections:

« Folder g RPMU - Remote Printer Management Ukility
« Printer File | Edit | Status Scan
» Configuration File
« Firmware File E insert ¥ Folder _c“]
Cut Printer
T Copy Configuration File
Firmware File
S — = a0 [statu
Delete  |4q) = Compuprint Pageiaster 2
IP Address= 10N 3005
HCOPG096
Folder
You are prompted for the name of the new folder. Enter the folder name and
select OK.
|
Hame:
I |
OK Cancel
HCOPG097
Printer

The Printer dialog displays to record printer identification values and network
parameters. The data entry dialog is divided into two different parameter groups:
Identification and Net.
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Identification | Met |

Hame
Model
User
Password
OK | | Cancel
HCOPG098
Name Enter the name for the printer.
Model This is a read-only field. The printer model is inserted by the
program as soon as it has discovered the printer identified by the
IP address (in the Net parameter group).
User Read only — name of printer's user
Password Read only — the encrypted password of the user

The Net parameter has the following attributes:

x|
[ Identification | Net |
IP Address  10.0.200.22
Hetmask 255.255.0.0
Port
Timeout
Workgroup |IBM_Group
Ok Cancel
HCOPGO99
IP Address Enter the printer's IP Address in this field.
Netmask Enter the Netmask that identifies the printer connection.
Port Enter the port number.
Timeout Enter the timeout value.
Workgroup Enter the printer's Workgroup in this field.

As soon as the new printer data are confirmed, the RPMU tries to contact the
printer to update its current status.

Note: If the printer is not found within the time indicated as Timeout, the RPMU
displays the printer in the database as “not ready”.

Configuration File

Selecting Configuration File displays the following dialog. Enter the name of the
configuration file, or look for it on your computer by selecting the Browse button.

The Remote Printer Management Utility
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Configuration File x|

[ | browse... |

| OK Cancel |

HCOPG100

Pressing OK allows the RPMU to insert the selected configuration file into the
current folder. See [‘Inserting a Configuration File into a Folder” on page 17/and
[‘Configuring the Printers in the Database” on page 18

Firmware File
Selecting Firmware File displays the following dialog. Enter the name of the
firmware file you want to download directly, or look for it on your computer by
selecting the Browse button.

Firmware File |
File Name:

| | browse... |

| ok || cancel

HCOPG101

Selecting OK allows the RPMU to insert the selected firmware file into the current
folder. See [‘Inserting a Firmware File into a Folder” on page 16| and [‘Updating the|
[Printer's Firmware Version” on page 26

Cut Selecting Cut removes the selected item (folder, printer, or file) from the database and
copies it into the paste buffer.

Copy Selecting Copy copies the selected item into the paste buffer. The selected item remains
unchanged.

Paste The item inserted in the paste buffer (with the Cut or Copy function) is put in the selected

position in the database tree.

Delete The selected item is permanently removed from the database.

The Status Menu

4 RPMU - Remote Printer Management Utility ¥
File Edit |Status Scan

E = Check Now
. Check List Printers W/E

¢ © MNet W Check Periodically

|
A

HCOPG102

Figure 7. The Status Menu

Check Now Selecting Check Now performs a check on all printers connected to the
network and updates all the printer status.

Check List Printers W/E Selecting Check List Printers W/E performs a check on all printers
connected to the network and shows only the printers that are in ONLINE,

8 Remote Printer Management Utility



or WARNING, or ALARM status as for the user selection.

Chosen printing status ll

| % Search printers with which status?

| ONLINE | | warNING | | ALaRM |

HCOPG103

Check Periodically Check Periodically enables or disables status polling. When Check
Periodically is selected the RPMU performs an automatic check every
about 10 seconds. See [‘Checking the Printer Status” on page 18

The Scan Menu

4 RPMU - Remote Printer Management Utility ¥0.6.0 - DE_D

File Edit 5tatus | Scan Help
= Printers Het Scan(insert
B =
Printers Net Scan{new)

PRl ctvork Scan

HCOPG104

Figure 8. The Scan Menu

Printers Net Scan(insert)
The RPMU searches for the connected printers within a specified |IP-address range by sending a
burst of directed SNMP requests to each IP address within the range. Any printer found in that
range is inserted into the existing Database.

x|
From 1o [fo [Jzo0 [fs0 | | start |
Mask 255 | [255 | |285 [[o |
To [0 |Jo | zoo|/s0 | | clear |
Time Ount 300( {(ms) Close

[~ wWorkgroup | |

™ Search for Printer containing text
S050|

HCOPG105

Printers Net Scan(new)
The RPMU searches for the connected printers within a specified IP-address range by sending a
burst of directed SNMP requests to each IP address within the range. The current database is
closed, and a new database is created.

The Remote Printer Management Utility 9



The Printer Operation Menu

i RPMU - Remote Printer Management Utility ¥0.6.0 - [}

File Edit Status Scan | Printer Operations | Help
E = .|| Printer Configuration __
s | ~ | Operator Panel :_-
@ & Network Scan Capture Printer Infos
@ cferal .
@ =5 Compuprint f_ R0t Printer Tt
HCOPG106
Figure 9. The Printer Operation Menu
Printer Configuration Use Printer Configuration to edit the configuration file of the printer you

selected in the database

Operator Panel Use Operator Panel to view the virtual operator panel of a printer you
selected on the screen.

Capture Printer Infos Use Capture Printer Infos to get display the configuration value of the
selected printer.

Reboot Printer Use Reboot Printer to reboot the selected printer.
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The Tool Bar

Figure 10. The Tool Bar

The tool bar shows a series of icons that allow an easier access to the menu functions:

=
=

Open a new database

|Create a new database]

Add a new folde

Save database

|Add a new printer|

[Add a new firmware filg|

|Add a new configuration file|

Copy an object]

|[Edit an object’s field|

Delete an object

|[Expand the information tree]

[Reduce the information tree]

[Send a firmware file to the devices|

HCOPG107

[Send a configuration file to the devices|

[Edit a configuration file|

|[Remote Panel management|

|Get the configuration from a device]

|Printer net scan (for update)|

|Printer net scan (new)|

Setting up the Printer Database

The RPMU's main features are the collection, organization, and management of the printer database.

The database may be set up manually or with an automatic discovery feature. The discovery feature
searches for connected devices and automatically adds them to the current database file.

The Remote Printer Management Utility 11



Graphic Conventions Used in the RPMU

The following icons are used in the RPMU windows:

? o

This symbol appears bes@e the folders and printer symbols. When selected, the object toggles

between an expanded ( ) or collapsed (O- ) view. The expanded view shows details for the
object; the collapsed view hides the details.
The printer in the database is ready and working normally.

The printer in the database is ready and working, but a consumable is running out. The printer will
probably need an operator’s intervention soon.

The printer in the database is in an alarm or standby state - no more jobs will be printed. An
operator’s intervention is necessary.

The printer connection is lost. An operator intervention is necessary. The printer has been removed or
the connection is interrupted.

Configuration File. The Configuration File may be added to a folder to indicate the current
configuration of the printers in that folder.

Firmware File. The Firmware File may be added to a folder to indicate the current firmware version of
the printers in that folder.

Automatic Device Discovery
This procedure is useful for setting up the printer database for the first time.

The RPMU searches for the connected printers within a specified IP-address range by sending a burst of
directed SNMP requests to each IP address within the range.

During the device discovery procedure the RPMU maps InfoPrint serial matrix printers for complete
management, getting the proprietary MIB objects supported. Third-party vendor devices are mapped for
basic status reporting only.

How to Start the Automatic Device Discovery

Start the first-time automatic device discovery by selecting the é icon (Printer net scan (new)) on the
RPMU's tool bar.

The following dialog is displayed:

12 Remote Printer Management Utility



x|

From 10 [0 [|zo0 a0 | [ start |
Mask 255 | [255 | [285 | |0 |

To [1o |Jo | zoo0]]so | [ clear |
Time Out 300( {ms) Close

[~ workgroup | |

[ sSearch for Printer containing text
gog0|

HCOPG135

The From and To IP-addresses define the start and stop addresses of the range in which the connected
printers will be checked. Mask defines the Netmask for the search procedure.

The value set for Time Out defines the time the program waits for a reply from a device connected to
each IP-address. If no printer is detected, after the time has passed, the program goes to the next IP
address within the range. The Time Out setting is useful when performing a device discovery procedure
on large networks that normally take a long time. The Time Out setting ranges between 300 milliseconds

(ms) and 100 seconds.

The value set for Workgroup in the text area defines the workgroup name of the printers to be searched.
The value set for Search for Printer containing text defines the text to be searched in the printer's
name.

Once the printers connected to the network have been discovered and identified with their IP-address,
they can be grouped in a logical way so that the user can access them quickly and easily.

The Remote Printer Management Utility 13



RPMU - Remote Printer Management Utility Ver.1.0 1Ol x|
File Edit Status Scan Help k

E B == S |5

+ &) Metwork Scan
L = mip e
¢ 5 1BM 4247-v03
Madel=IBM 4247-Y03 Version 2.07 M.Rev. 5102
IP Address=917.162.232
Metmask= 2552552550
Waorkgroup = IBM_Group
User 1D = root
o 5 1BM 4247-L03
Model=1BM 4247-L03 Version 1.00 M.Rev. 0003
IP Address=9.17.162.233
MNetmask= 2552552550
Warkgroup = IBM_Group
User 1D = root
7 h1BM 4247-003
Model=1BM 4247-003 Version 7.10 M.Rev. 5002
IP Address=917.162.234
MNetmask= 255.255.255.0
Warkgroup = IBM_Group
UserID = root
T 2§ InfoPrint 6700 Version 1.4.36.2 3-3-3
Model = InfoPrint 6700 Version 1.4.36.2 3-3-3
IP Address=917.162.235
Metmask = not_detected

Fuuml 11 printers!!

[»

-

HCOPG136

Figure 11. Logical Grouping of Printers in the Database

The logical groups can be defined hierarchically allowing for navigation through nested device groups. The
discovered printers can then be placed into each group.

This structured database can be saved to disk and then retrieved.
The organization process of the devices is performed through the following functions:

Creating a New Database
Use this procedure for organizing your printers.

The RPMU allows you to create various printer databases and then organize the corresponding printers
into folders and subfolders, reproducing the structure of single offices, departments, or the whole company.

=

1. To create a new database, select the icon (Create a new database) on the tool bar. The
Database Name dialog is displayed.

Database Name x|

Hame:

OK Cancel

HCOPG110

2. Enter a database name.

14 Remote Printer Management Utility



Now you can structure and organize the database as follows:

Adding a New Folder

1. Select Edit = Insert = Folder or select the ‘— icon (Add a new folder) on the tool bar. The
RPMU prompts you for the folder name.

Folder Name x|

Hame:

OK Cancel

HCOPG111
2. Enter a name for the printer group you want to create and then select the OK button.

Note: The RPMU is able to manage nested folders. The printer database may be structured as needed.

Organizing the Folders
Reorganize the Printers Already Present in the Database

If you performed the automatic device discovery procedure described above, you will already have a list of
printers connected to the network. In this case you have to reorganize these printers in the folder structure
you created with the cut and paste procedure:

B

Select the printer to put in the new folder and then select the
= Cut).

icon (Cut an object) (or select Edit

Select the folder in which you want to put the printer and then select the @
(or select Edit = Paste).

The printer and the corresponding information now appear in the folder.

icon (Paste an object)

Manually Inserting a Printer

To manually insert a printer at any time while organizing the database, as either the first printer or in
addition to the existing printers in the database, proceed as follows:

1. Select the folder in which you want to insert the printer and then select the icon (Add a new
printer) on the tool bar (or select Edit == Insert = Printer).

2. The RPMU displays the printer data dialog box, in which you must enter the printer's parameters. It is
necessary to specify the printer name (ldentification parameter group), the IP Address, and Netmask
(Net parameter group).

The Remote Printer Management Utility 15
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If’ldem'rﬁcatiun rNet | Identification HNet
IP Address
MHame o o
Model e
Port
User K
Timeourt
Password
Workgroup
ok || cancel ok || cancel

HCOPG112

Figure 12. Printer Data Dialog Boxes

Note: For more information about how to fill in these dialog boxes, see [‘The Edit Menu” on page 5|

As soon as the new printer data are confirmed, the RPMU tries to contact the printer in order to update its
current status.

Note: If the printer is not found, the RPMU displays the printer in the database as “not ready”.

Inserting a Firmware File into a Folder

A firmware file may be inserted into a folder to indicate the firmware version loaded on the printers
contained in this folder.

1. Select the |— icon (Add a new firmware file) on the tool bar (or select Edit = Insert = Firmware
File), the Firmware File dialog is displayed.

Firmware File x|

File Hame:

|| browse... |

| Ok || Cancel |

HCOPG113

2. Select the browse ... button, select the firmware file you want to insert into the folder, then select OK.

3. The Firmware File is shown in the selected folder with its identifier graphic j .

Note: No firmware download is performed when inserting the firmware file into the folder.

For information on how to download a new firmware version to the printers, see [‘Updating the Printer's|
[Firmware Version” on page 26|

Note: More than one firmware file can be added to each folder.

16 Remote Printer Management Utility




Inserting a Configuration File into a Folder
A configuration file may be inserted into a folder to indicate the configuration set on the printers contained

in this folder.
]
1. Press the icon (Add a new configuration file) on the tool bar (or select Edit = Insert =

Configuration File), the Configuration File window appeatrs.

x|

Configuration File

File Hame:

i | browse... |

| OK Cancel |

HCOPG114

2. Press the browse ... button, select the Configuration File you want to insert into the folder, and press
OK.

3. The Configuration File is shown in the selected folder with its identifier graphics E .

Note: No configuration updating is performed when inserting the configuration file into the folder.

For information on how to update the configuration of the printers, see [‘Configuring the Printers in the]
[Database” on page 18

Note: More than one configuration can be added to each folder.

Changing the Database Structure

To further organize the folders, printers, firmware, and configuration files in the database, you can use the
following tool bar icons:

Cut an object

Copy an object

Paste an object

Edit an object's field

X N [ | [3<

Delete an object

Optimizing the Database Display
Use the following icons to expand or hide the folders, subfolders, and printer information in the database
window.

T Expand the information tree - Reduce the information tree

The Remote Printer Management Utility 17



You can select the o symbol to toggle between the expanded and reduced view of the information
tree.

Printer Database Management

Checking the Printer Status

Use RPMU program to check the status of the printers connected to the network. The Status Function in
the RPMU menu offers three selections:

% RPMU - Remote Printer Management Utility ¥

File Edit | Status | Scan

—| Check Now :
=2 = |
Check List Printers W/E
e
7

e

Met

Siera

¥ Check Periodically

HCOPG115

Check Now RPMU checks on all the peripherals in the database and updates their statuses.

Check List Printers W/E RPMU checks on all printers connected to the network and shows only the printers that
are in ON LINE, WARNING, or ALARM state.

Check Periodically Enables or disables status polling. When the Check Periodically is selected, the RPMU
performs an automatic check approximately every 10 seconds.

After the check the printers in the database are shown with the corresponding status indication:

The printer in the database is ready and working normally.

The printer in the database is ready and working, but a consumable, such as paper, is running out.

= The printer will need an operator's intervention soon.
® The printer in the database is in alarm or standby - no more jobs will be printed. An operator's
= intervention is necessary.
The printer in the database is not connected. The printer has been removed or the network
connection is interrupted. An operator's intervention is necessary.

Configuring the Printers in the Database

With the RPMU you can read a printer's configuration, edit it, store it to disk, and download the updated
configuration to the printer.

The best way to proceed is to read the existing configuration from the printer and to change it as
necessary.

18 Remote Printer Management Utility



Retrieving a Configuration from a Printer

Note: This feature is only available for InfoPrint Solutions Company Serial Matrix printers.
1. Choose the printer configuration you want to upload by either:

c
* Opening the saved configuration file previously uploaded by selecting the : icon (Edit a

configuration file icon) on the tool bar or with the “Printer Configuration” in the “Printer Operation”
menu.

or

£ =L
» Upload the configuration file with the current settings for the printer by pressing the g icon (Get
the configuration from a device) on the tool bar or by way of the Capture Printer Infos in the
Printer Operation menu.

The RPMU opens the Configuration Editor showing the configuration tree for editing.

U B, Printer Configurator .0.2.0 (IP: 10.0.200.42) x|
. File Configuration

™ Configuration Menu -
‘1@ O3 Firmware Informatian
D Base Code
[y Lan code
? (] Canfiguration Storage
D Power-On Custom Set
D Power-0n Paper Source
@ [ Attachment
[ attachrent
@ [] Rear Tractor Use
[ rear Tractor Use
@ [ Print Custom Sets
@ [ Customn SetA
@ [ LAN IPDS Configuration
[ Character Per Inch
D Lines PerInch
[y Maxirnurn Print Position
[ Maxirnurn Page Length
(Y Print Quality

[4]

HCOPG116
Figure 13. Printer Configuration Window

For each parameter, you can see the range of possible choices and the default setting by clicking on the
parameter in the tree. For example, [Figure 14 on page 20| shows the Maximum Print Position parameter.

The Remote Printer Management Utility 19
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] & Printer Configurator v.0.2.0 {IP: 10.0.200.42)
. Rle Configuration

1 Configuration Menu
‘| O3 Firrrweare Infarmation
D EBase Code
|__°'| Lan Code
Q@ =5 Canfiguration Starage
D Fower-On Gustom Set
D Fower-0n Paper Source
@ [ Attachment
|__°'| Attachment
@ [ Rear Tractor Use
D Rear Tractor Use
@ [ Print Custorn Sets
@ [ custom Set A
% I LaM IPDS Configuration
D Character Per Inch
D Lines FPer Inch
D Maximurm Print Position
D Maximum Page Length
[y Print Quality

Maximum Print Position (dft.; 132)

132

Figure 14. Maximum Print Position parameter

Editing a Printer Configuration

For each parameter in the printer configuration tree you can select the desired value.

132
133
134
135
136
137
138
139

[ b

[4]

(4]

HCOPG117

1. Select the configuration parameter you want to set. The Printer Configuration Manager is displayed.
The lower part of the window displays the default value and the currently set value of the parameter.
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{ & Printer Configurator ¥.0.2.0 (IP: 10.0.200.42)

File Configuration

[ Configuration Menu
| ® 3 Firmware Infarmation
[ Base Code
D Lan Code
] | Configuration Storage
D Fower-COn Custam Set
D Fower-0n Paper Source
§ [ attachment
D Aftachment
© [ Rear Tractor Use
[ Rear Tractor Use
@ [ Print Custom Sets
@ [ custam Set
§ CILAN IPDS Configuration
D Character Per Inch
D Lines Per Inch
[ Maxirmurn Print Position
[ Mavirmurn Page Length
[ Print Quality

Mazimum Print Position (dft.: 132)

192
133

L]

Field Name

Default Value

134
135
136
137
138
139 =

Figure 15. Printer Configuration Manager

2. Select the
is shown for the selection.

HCOPG118

—— Possible Choices

symbol on the right side of the current value. The pull-down list of the possible values

3. Click on the value shown in the current value field. The pull-down menu closes and the new value is

set.

Set all the parameters in the same way.

Note: The values set are only stored in your PC's RAM; no value has been set on the printers in the

database.

You may now send the new settings to the printer and/or save the configuration file with the new settings

on the hard disk of your PC.

Sending the Configuration to the Printers
Once all the parameters in the configuration tree have been set the new configuration must be sent to the

printers.

1. In the Printer Configurator menu, select Configuration. You have two download possibilities:

£ Printer Configurator v.0.3.0 (Printer: IBM 4247-L03 Yers

9

Selecting:

Configuration

Retrieve

Send Modified Values

Send All Values

Restore Default Configuration

—

TUIAFT TIMATTTT

HCOPG120

a. Send Modified Values Only the updated values are sent to the selected printers. This procedure is

fastest.

21
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b. Send All Values The whole set of configuration parameters is sent to the printers. This procedure
assures that all configured printers have identical settings.

Restore Default Configuration Restore the default Configuration into the working configuration file (not sent to
printer).

2. Selecting either Send Modified Values or Send All Values in the Printer Configurator menu, the
printer asks to confirm the selection.

What do You say..? x|

? Send this Configuration to Printer?

Yes No Cancel
HCOPG121
Yes Begins downloading the updated configuration (see step 3).
No The configuration is not downloaded and the RPMU displays again the Main Window.
Cancel The configuration is not downloaded and the Printer Setup tree is displayed for further

changes.
3. Selecting Yes sends the updated configuration to the printer.

_)ﬂj
[ bas i
O Lz
9 [ Configy
O
O Paw
[ Atta
9 ERearTr
D B #l Sending Configuration to Prinkter... 11‘
@ ? S - | 27% |
% =1 Sending configuration...
i)
D i
Oy b
[ w:
i) -
Sending Configuration, please wait...

HCOPG122

Figure 16. Sending the Configuration to the Printer

The program shows the progression bar during the download. At the end of the download procedure the
printer is restarted with the new settings.

Saving the Configuration File to Disk
Once all the parameters in the configuration tree have been set, the configuration may be saved to disk.

This allows you to have different configuration files for updating your printers.
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1. After editing the configuration tree, select File in the Printer Configurator menu.

& Prnter Configurator ¥

File | Configuration

Open  :zr Macro
Saye Macroi

Exit |__°‘| LineSpace
= [ 1 ineGnare

HCOPG123

2. Select Save. The RPMU prompts you for a file name and folder.
3. Enter a name for the configuration file and Select OK.

4. The configuration file is saved to disk. You may load it for editing and/or updating a printer with these
settings.

Updating a Printer or a Group of Printers Using an Existing Configuration File

The configuration files on your computer may be used to update the printers in the network. For example,
when new printers are installed and should be configured as the other printers in the same group or for
reconfiguring all printers of a group. Proceed as follows:

1. In the Main Window of the printer database position the cursor on the folder containing the printers to

<]
configure, then select the _la'— icon (Send a configuration file to the devices). The program shows
the Configuration File selection window.

]

Configuration File -
File Hame:

| hrowse...

OK Cancel |

HCOPG124

2. Enter the file name, or select the browse... button to select a configuration file.

The RPMU shows the list of the devices that are compatible with the selected configuration file.
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& Configuration compatible printers list _ ﬂ

|8 [, dasgrs] 1IBM 4247-1.03 (10.0.200.22)

Unselect All Send Close Save Result

HCOPG125
Figure 17. List of Compatible Devices

In this dialog, you can select or deselect the printers that you want to configure by selecting the check field
() beside the printer or selecting the first button at the bottom of the screen:

Unselect All / Select All This button selects or unselects all of the printers in the list.

Save Result This button saves the list of shown compatible devices and all their
information in the selected .TXT file.

Once the printers are selected, select the Send button. The Configuration File begins downloading.
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C [v] [My Enterprise, Engineering] IBM 424703 [status: READY <A>]{10.0.200.40)
3 [¥] [My Enterprise, Engineering, Manufacturing] IBM 4247 03 [status: READY <h=] (...

sending Configuration ... g x|

| [My Enterprise, Engineering] IBM 4247-V03 [status: READY <f>] |

| Character Per Inch |

Stop

?rimer side: Display Language Correcthy receved
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Figure 18. Downloading the Configuration File

* The first line on the screen indicates the printer that is being configured.
» The second line indicates the parameter that is being updated.

Once the printers have been configured the RPMU shows the result of the download:
» If the download was successful, the printer is checked with a green check sign.

X

<A>] (10.0.200.40)
- | 2 [¥] [My Enterprise, Engineering, Manufacturing] IBM 4247 w03 [status: READY <fA=] (...
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 If an error occurred during the download, the printer is checked with a red cross sign.

1 [v] [My Enterprise, Engineering] IBM 4247.V03 [status: READY <A>](10.0.200.40)
I8 [v] [My Enterprise, Engineering, Manufacturing] IBM 4247 V03 [status: READY 28] ..
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Note: When the configuration parameters have been sent to the printer, it is re-initialized to set the new
printer configuration.

After a group of printers has been updated, insert the configuration file used for the update into the folder
containing the updated printers. See [‘Inserting a Configuration File into a Folder” on page 17|
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Updating the Printer's Firmware Version

The firmware downloading utility allows you to upgrade either the base board or the LAN card flash
content.

A single download operation can be done on a list of peripherals belonging to the same folder in the
Printer Database.
1. In the RPMU Main Window select the folder containing the printers for which you want to update the

firmware, and select the E icon (Send a firmware file to the devices) on the tool bar.
2. The program displays the Firmware File selection window.

Firmware File x|

File Name:

|| browse... |

| OK | | Cancel |

HCOPG129
3. Enter the file name or select the browse... button to select the firmware file.

The RPMU shows the list of printers that are compatible with the selected firmware file.

£ Firmware compatible printers list il

o [, dasgfs] IBM 4247-L03 [status: ON LINE M1] ({10.0.200.22)

Unselect all Send Close Save Result

HCOPG130

Figure 19. List of Compatible Printers

In this dialog, you can select or deselect the printers to which you want to download the firmware file by
selecting the checked field ( »* ) beside the printer or pressing on the first lower button:

Unselect All / Select All This button selects or unselects all of the printers in the list.

Save Result This button saves the list of shown compatible devices and all their
information in the selected .TXT file.
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Press the Send button to start downloading the Firmware Files to the selected printers.

When the printers have been updated the RPMU shows the result of the download:
 If the download was successful, the printer is checked with a green check sign.

! & Firmware compatible printersflist o |
| ‘@J’ [¥] [My Enterprise, Engineering, Manufacturing] IBM 4247 V03 [status: READY <A>] {‘
HCOPG131

» If an error occurred during the download, the printer is checked with a red cross sign.
! & Firmware compatible printersist G |
<f>] ...

| ‘ I# vl [My Enterprise, Engineering, Manufacturing] IBEM 4247 Y03 [status: READY

Note: After firmware downloading the printer is restarted with the new code release.
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After a group of printers has been updated, insert the configuration file used for the update into the folder

containing the updated printers. See [‘Inserting a Firmware File into a Folder” on page 16|

Configuring a Printer With the Virtual Operator Panel

For InfoPrint Solutions Company Serial Matrix printers, you can call up the corresponding virtual operator

panel with all the keys, LEDs, and the display.

You can then perform all printer operator panel functions on your computer in the same way as if you were

in front of the printer. Click on the operator panel keys with your mouse.

The following shows the virtual operator panel of the printer.

4247-L03 Yersion 00.07 M.Rev. 0003 x|
[ FRONT
B FRONT 2
F)H LINE M1
oy =
u] ] L R FROGRAM OH LINE
B b |
FATH TEAR ALTERHA.. LOADMFF LF FONT MACRQ
PARK PITCH 0 MICRO FEED U

HCOPG133

Figure 20. The Virtual Operator Panel

To call up the virtual operator panel:
1. Select the printer for which you want to see the virtual operator panel.

Printer Operation menu.
2. The corresponding operator panel appears on the screen.

The Remote Printer Management Utility
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Note: For more details on the operator panel functions, please see the user manual of the corresponding
printer.

Updating the Printer’s List in the Database

When printers are connected to or removed from the network, you can update the structure by performing
an update net scan. During the device discovery procedure the RPMU maps InfoPrint Solutions Company
printers for complete management getting the proprietary MIB objects supported. Third-party vendor
devices are mapped for basic status reporting.

The update automatic device discovery is started by selecting the | % icon (Printer net scan (for
update)) on the Remote Printer Manager's tool bar. The following dialog is displayed:

x|
From |10 [Jo [[e00 [t | | start |
Mask - ||+ ||+ [lo |
To 1o |Jo |Jzo0 ||1ioo | | clear |
tins o |l )

I~ Workgroup | |

[” Search for Printer containing text
1B

The From and To IP-addresses define the start and stop addresses of the range in which the connected
printers are checked. Mask defines the Netmask for the search procedure. The value set for Time Out
defines the time the program waits for a reply of a device connected to each IP-address. After the time
has passed, if no printer is detected, the program goes to the next IP address within the range. Setting
Time Out is useful when performing a device discovery procedure on large networks.

The value set for Workgroup in the textbox defines the workgroup name of printers to be searched. The
value set for Search for Printer containing text defines the text to be searched into the printer name.

Once the printers connected to the network have been discovered and identified with their IP-address,
they may be grouped in a logical way so that the user can access them quickly and easily.
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Figure 21. Logical Grouping of Printers in the Database

Note: Discoveries are started by selecting the corresponding icon on the RPMU tool bar. No means for

automatically detecting new devices are provided.
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The found printers may be organized as previously described in this manual.

Software Installation and Documentation

The Remote Printer Management Utility software can be downloaded from our web site at

www.infoprint.com

Remote Printer Management Utility installation files
Auto Installation for Microsoft environment

Installation shell script for Unix and Linux environments
User Guide in PDF format

Software license agreement

The Remote Printer Management Utility
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Notices

This information was developed for products and services offered in the U.S.A.

InfoPrint Solutions Company may not offer the products, services, or features discussed in this document
in other countries. Consult your local InfoPrint Solutions Company representative for information on the
products and services currently available in your area. Any reference to an InfoPrint Solutions Company
product, program, or service is not intended to state or imply that only that InfoPrint Solutions Company
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any InfoPrint Solutions Company intellectual property rights may be used instead.
However, it is the user’s responsibility to evaluate and verify the operation of any non-InfoPrint Solutions
Company product, program, or service.

InfoPrint Solutions Company may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270

U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INFOPRINT SOLUTIONS COMPANY PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
InfoPrint Solutions Company may make improvements and/or changes in the product(s) described in this
publication at any time without notice.

Any references in this information to non-InfoPrint Solutions Company Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for this InfoPrint Solutions Company product and use of
those Web sites is at your own risk.

InfoPrint Solutions Company may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Information concerning non-InfoPrint Solutions Company products was obtained from the suppliers of
those products, their published announcements or other publicly available sources. InfoPrint Solutions
Company has not tested those products and cannot confirm the accuracy of performance, compatibility or
any other claims related to non-InfoPrint Solutions Company products. Questions on the capabilities of
non-InfoPrint Solutions Company products should be addressed to the suppliers of those products.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
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Trademarks

These terms are trademarks or registered trademarks of InfoPrint Solutions Company in the United States,
other countries, or both:

InfoPrint
Infoprint

IBM and the IBM logo are registered trademarks of International Business Machines Corporation in the
United States, other countries, or both.

Ricoh is a registered trademark of Ricoh Co., Ltd., and its affiliated companies.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.
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